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1 Introduction 

1.1 Description 
The ARCNET Evaluation System (ARC-EVS) is a very useful tool for exploring embedded 
ARCNET.  The system contains: 

• one ARCNET Evaluation Board (ARC-EVB) 

• one PCI22-485X ARCNET network interface module (NIM) 

• one wall-mount power supply 

• one null-modem cable 

• one modular cable 

• one RJ-11 modular cable terminator 

• one RJ-45 modular cable terminator 

• one CD-ROM 
 

 
Figure 1 �ARC-EVS Components 

The ARC-EVB contains a microcontroller that allows users to upload their firmware into FLASH 
and execute it.  It also works with the Keil compiler, which allows users to debug their ARCNET 
code on the board.  The CPU is provided with external RAM to allow users to load up to 30 KB 
of firmware. The PCI22-485X is a PCI-based COM20022 ARCNET card. When the card is 
installed in a computer and connected to the ARC-EVB via the provided modular cable, a 
complete ARCNET network is created. 
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1.2 Kit Features 

• ARCNET compliant (ANSI/ATA 878.1) 

• Industrial temperature range (�40ºC to +85ºC) 

• Employs standard TTL signal levels 

• Dual RJ-11 jacks for EIA-485X ARCNET 

• Dual D-Sub 9 plugs for serial communication 

• Prototyping area with dual resettable fuses for Vcc 

• Linear power supply 

• One 8-pole DIP switch for Node ID 

• One 8-pole DIP switch for data input 

• 8 LEDs for input indication 

• 8 LEDs for output indication 

• LED for power indication 
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1.3 ARCNET Evaluation Board Specifications 

Electrical 
Power Requirements: 
 Power Consumption: 1.8 W, maximum (with all LEDs lit) 
 Voltage: 9�24 VDC 
 Current: commensurate with applied voltage 

Environmental 
 Operating Temperature: 0ºC to+60ºC 

 Storage Temperature: �40ºC to+85ºC 

Data Rates 

 10 Mbps, 5 Mbps, 2.5 Mbps, 1.25 Mbps 

Dimensions 

 7" x 4"   (178 mm x 102 mm) 

Functional 

 Digital Signals: Number Type 
 Input or Output: 8 TTL, 5 V 
 Input Signal Voltage: 0�5 V 
 Maximum Output Low: 450 mV, 1.6 mA 

 Minimum Output High: 4.5 V, 10 µA 
 Serial Port: TTL, 5 V 
ARCNET Compliance ANSI/ATA 878.1 

LED Indicators 

Function Number Color 
 Power 1 Green 

 CPU Access 1 Yellow 

 Fieldbus Data Received 1 Green  

 Input Signals 8 Red 

 Output Signals 8 Red 
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1.4 PCI22-485X Specifications 

Environmental 
 Operating Temperature: 0ºC to+60ºC 

 Storage Temperature: �40ºC to+85ºC 

Data Rates 
 10 Mbps, 5 Mbps, 2.5 Mbps, 1.25 Mbps 

Dimensions 
 4.20" x 5.5"   (107 mm x 140 mm) 

I/O Mapping 
 Requires 16 bytes of I/O space for COM20022 controller 

Interrupt Lines 
 Supports PCI INTA 

Compatibility 
 Fully compatible with all of Contemporary Controls ARCNET products and PCI bus 

computers. 

Regulatory Compliance 
 CE Mark 
 FCC Part 15 Class A 

Power Requirements 
 Voltage: +5V  
 Current: 400mA 

LED Indicators 

Function Number Color 
 Host CPU Access 1 Yellow 

 Fieldbus Data Transmitted 1 Green  
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1.5 Fieldbus Connectors 

Two cabling methods are provided for the fieldbus and differ by their connector type. 

Identical open-wire, 3-terminal connectors are available on both the ARC-EVB and the NIM: 

 
The ARC-EVB modular connector is of the RJ-11 type: 

 

The NIM modular connector is of the RJ-45 type: 

Open-Wire Connector 
Pin Assignments 

Pin Usage 
1 Signal 

2 Signal 

3 Shield 

RJ-11 Modular Connector 
Pin Assignments 

Pin Usage 
1 Not Installed 

2 Not Used 

3 Signal 

4 Signal 

5 Not Used 

6 Not Installed 

RJ-45 Modular Connector 
Pin Assignments 

Pin Usage 
1 Not Used 

2 Not Used 

3 Not Used 

4 Signal 

5 Signal 

6 Not Used 

7 Not Used 

8 Not Used 



 

2 ARC-EVB Description 

The core of the ARC-EVB is an Atmel T89C51 CPU which contains 16 KB of FLASH memory to 
hold the provided test application (Modbus-over-ARCNET)�or the user�s firmware.  The FLASH 
memory can also hold the Keil monitor, allowing it to work with the Keil compiler/debugger. 
The ARC-EVB also contains an SMSC COM20022 ARCNET controller (backward compatible 
with the COM20020) which can support data rates from 156 kbps to 10 Mbps using a 20 MHz 
crystal.  This chip offers enhanced features over earlier generation chips.  New features include 
command chaining, sequential access to internal RAM, duplicate Node ID detection and variable 
data rates up to 10 Mbps. 
An 8-bit DIP switch (S1) is 
provided as the input device and 8 
associated LEDs report the state 
of each input.  An additional 8 
LEDs indicate the states of the 
output signals.  LED 7 in each 
array is the MSB. 
Another 8-bit DIP switch (S2) is 
used for setting the ARCNET 
Node ID.  Switch 8 is the MSB. 
The data rate is set by jumpers at 
jumper block J8. 
The ARC-EVB uses an HYC4000 
transformer-coupled ARCNET 
transceiver. This provides 
balanced EIA-485 signaling so 
that either a straight-through or a 
crossover cable can be used. 
ARCNET fieldbus connections 
are provided by either a 3-
terminal open-wire connector or 
an RJ-11 jack for standard 
twisted-pair cable.  An extra RJ-
11 jack is provided for installing 
the modular terminator provided 
in the ARC-EVS.  The extra jack 
can also be used for daisy-
chaining a twisted-pair bus if the 
ARC-EVB is configured with 
more than one ARCNET adapter. 
Contemporary Controls 
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Figure 2 � Evaluation Board Block Diagram
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Table 1 � Connectors 

 Type Usage Comment 
S1 8-pin DIP Data Input Set to desired data value 
S2 8-pin DIP ARCNET Node ID Set to ARC-EVB ARCNET node ID 

Table 2 � Switches 

 
 Usage 

TP1 VCC 
TP2 GND 
TP3 Pulse1 ARCNET signal 
TP4 RXIN received ARCNET 
TP5 TXEN transmit enable 
TP6 EIA-485 output (Φ B) 
TP7 EIA-485 output (Φ A) 

Table 3 � Test Points 

 
DR0 DR1 DR2 Data Rate 

� � � 2.5   Mbps 
X � � 1.25  Mbps 
� X � 625 *  kbps 
X X � 312.5 * kbps 
� � X 156.25 * kbps 
X � X 5  Mbps 
� X X 10  Mbps 
X X X N/A 

( X = jumper installed ) 

Table 4 � Data Rate (J8) 

* These rates are not supported by the 
ARC-EVB transceiver, but are available if 
the user wishes to replace the ARC-EVB 
transceiver with a custom transceiver. 

J1 2-pin header Boot ROM (for FLASH reprogramming) Leave off in normal operation 
J2 D-SUB 9 CPU UART Firmware upload and debug 
J3 D-SUB 9 Extra serial port Customer SPI development 
J4 RJ-11 ARCNET RJ-11 port Connect to PCI22-485X 
J5 RJ-11 ARCNET RJ-11 port Connect terminator here 
J6 Open 3-wire ARCNET 3 wire port Extra ARCNET port 
J7 30-pin header Prototyping header  
J8 6-pin header ARCNET data rate Set to desired rate (Table 4 � 

Data Rate (J8)) 
J9  Power input connector Using provided power supply 
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3 PCI22-485X  NIM 

3.1 Description 
The PCI22-485X is one of a family of Contemporary Controls network interface modules (NIMs), 
each serving to link a PCI bus compatible computer with the ARCNET local area network (LAN).  
Each model within the family is identified by a model number ending in a 3- or 4-character suffix.  
This suffix specifies a transceiver type which matches a particular type of cable.  Because the 
capabilities of each transceiver differ, different models cannot occupy the same LAN segment. 
The PCI22-485X supports data rates from 1.25 Mbps to 10 Mbps  and operates in a Windows 
environment with one of our null stack drivers.  The driver directory on the CD-ROM provides a 
selection of null stack drivers from which to choose. 
This NIM incorporates the same ARCNET controller chip as used on the ARC-EVB.  Bus 
contention problems are minimized since the interrupt level and I/O base address are assigned 
through Plug and Play.  There is no requirement for wait-state arbitration. 
Two LEDs monitor network operation and bus access to the module.  An external DIP switch 
allows node addresses to be easily reassigned without removing the module. 

3.2 Hardware Installation 
The NIM can be installed in any PCI bus compatible computer bus.  With power detached from 
the computer, remove the computer cover to expose the motherboard and expansion slots 
(connectors).  Care should be taken when installing the card; both it and the exposed 
motherboard are sensitive to electrostatic discharge.  To prevent inadvertent damage, touch the 
metal case of the internal power supply to discharge yourself then remove the card from its 
protective ESD package.  Remove the backplate of the computer adjacent to the desired slot 
(connector).  Then insert the card into this slot by applying an even downward pressure until it 
firmly seats in the connector.  The card�s backplate can be fastened to the computer with the 
small screw used to attach the original backplate.  Hardware installation is completed by 
replacing the computer�s cover. 

3.3 Software Installation 
Unlike ISA bus computers, PCI bus computers usually have their resources assigned by the 
operating system.  The PCI22-485X NIM requires one interrupt line and a 16 byte I/O range for 
the COM20022 ARCNET controller. 
Once the NIM is inserted and power applied to the computer, Windows will recognize the card 
and ask the user for the driver location.  Point to the folder appropriate to the version of 
Windows being used.  After loading is complete the driver will be active.  The driver can be 
disabled from the Device Manager. 
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3.4 Indicator Lights 
There are two LEDs located at the NIM�s backplate.  The green LED indicates that the card is 
transmitting ARCNET traffic to the network.  The yellow LED indicates that the card is being 
accessed from the host computer via its I/O address. 

Figure 3 � PCI22-485X Indicator Lights and Node ID Switch  

3.5 Node ID Switch 
Although not always needed, this NIM has a separate input port that reads an 8-bit DIP switch 
(SW1) located at the backplate.  This switch is meant to serve as a Node ID switch, although it 
can serve as a general purpose switch if desired.  The switch has no connection to the 
COM20022 controller chip. 
The most significant bit (MSB) is switch position 8, and the least significant bit (LSB) is switch 
position 1.  A switch in the open position (off position or away from the printed circuit board) 
introduces a logic �1.�  In the example below, the switch is set to hexadecimal address AF. 

3.6 Fieldbus Connection 
The PCI22-485X NIM supports AC-coupled communication via its daughter board which has a 
fixed-bias network isolated by a pulse transformer.  Unlike DC-coupled devices, bias adjustment 
is unneeded and wiring polarity is unimportant.  Dual RJ-45 jacks and one three-position screw 
terminal connector are the options for attaching the field bus wiring.  For convenience, a 
modular cable is provided for connecting the NIM to the ARC-EVB. 
Each end of the fieldbus wiring must have a proper value of termination resistance.  The NIM 
provides two options to achieve proper termination: 
Onboard Termination:  Install the E1 jumper on the daughter board to apply an onboard 
resistance across the twisted-pair.  If the jumper is removed, no termination is applied. 
External Termination:  If you wish to enable or disable termination without removing the NIM 
from the host computer, external termination can be used.  In this case, remove jumper E1 and 
insert either the provided RJ-45 modular terminator in the unused RJ-45 jack or a 120 ohm 1/4 
watt resistor across pins 1 and 2 on the screw terminal connector. 
NOTE:  Terminating with a value less than 100 ohms will excessively load the EIA-485 
transceivers�so you must only use one method of termination at a time.  If more ARCNET 
devices are attached to the NIM and the ARC-EVB in a bus topology, only apply termination to 
the devices located at the ends of the bus. 
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4 Source Code 

The ARC-EVB is provided with Modbus-over-ARCNET example code for both server and client. 
When the server example code is executed on the ARC-EVB, it can receive one byte of output 
data and can transmit one byte of input data when polled by the Modbus client.  The 8 LEDs on 
the ARC-EVB are used to indicate the received output data.  The 8-bit DIP switch (S1) is used 
to provide ARC-EVB input data.  
The client software executes on a PC in which our PCI22-485X has been installed and requires 
the version of our Null Stack driver appropriate to the version of Windows being used.  The 
Modbus client will continually request current Modbus data from the Modbus server (ARC-EVB) 
and will also update server output data when modified by the user. 
The ARCNET Control Panel is illustrated in Figure 4.  The server application causes the current 
ARC-EVB input data to be displayed in the LED Status section of the panel and can change the 
ARC-EVB output data in the LED control section of the panel.  The 8 output LEDs on the ARC-
EVB are used to display its output state. 
Also included is a Keil monitor HEX file that (when copied to the ARC-EVB) allows the ARC-
EVB to communicate with the Keil debugger.  The HEX file for the Modbus-over-ARCNET 
server is also provided.  This allows the user to switch between debugging with the Keil 
compiler and executing the Modbus-over-ARCNET server. 
Updated versions of Modbus-over-ARCNET client and server can be downloaded from 
www.ccontrols.com. 

www.ccontrols.com
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5 Modbus-over-ARCNET Setup 

Confirm that the PCI22-485X NIM has been properly installed in the host computer (as per 
Sections 3.2 and 3.3) and that the ARC-EVB EEPROM contains the Modbus hex file.  The 
ARC-EVB has been factory programmed with the Modbus firmware�so loading this firmware 
will only be needed if it has been erased.  (See Section 7 for firmware modification). 

PCI22-485X NIM Setup: 

• Set the NIM�s Node ID switch to  the desired value (1�255, decimal) as per Section 3.5. 
 Optionally, the Node ID can be set via the Windows Application below. 

• Make sure the NIM has proper cable termination applied as per Section 3.6. 

ARC-EVB Setup: 

NOTE: The ARC-EVB will initialize with Data Rate and Node ID values existing during power 
up.  Changes to these parameters will have no effect unless power is recycled. 

• Set the Data Rate jumpers (J8) to the desired data rate as per Table 4 � Data Rate (J8). 

• Set the Node ID DIP switch (S2) to a Node ID that differs from that set on the NIM. 

• Install jumper JP1 to invoke onboard fieldbus termination. 
 Optionally, the provided RJ-11 modular terminator may be inserted in the unused RJ-11 jack. 

• Apply power. 

Fieldbus Setup: 

• Connect the NIM to the ARC-EVB with the provided modular cable.  
 Optionally, any CAT-5 twisted-pair cable may be attached between the open-wire connectors. 
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Windows Application Setup: 

• Launching the application will display the Control Panel in Figure 4.  Until the Settings 
Panel options have been entered, the Control Panel features will remain inactive. 

Figure 4 � ARC-EVB Control Panel � Inactive 

• Selecting the Settings menu item will display the Settings Panel in Figure 5. 

Figure 5 � Application Settings 

• In the Node ID box enter the ARCNET Node ID to be associated with the NIM (and its 
host computer).  A zero value causes the Node ID to be read from the NIM�s DIP switch. 

• The Board Number field specifies how many ARCNET NIMS are installed in the host 
computer.  The default value of �1� rarely needs changing.  If more Contemporary 
Controls PCI-based NIMS are installed, enter that number. 

• In the Data Rate box select the data rate which matches that set on the ARC-EVB. 
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After completing the settings, the Control Panel will appear as in Figure 6.  Three fields are 
�dimmed� because they are read-only � Read Status, Control Status and Number of Recons. 

Figure 6 � ARC-EVB Control Panel � Active 

• Enter a hex value for the Destination Node ID which agrees with the DIP switch value set on 
the ARC-EVB.  This value must differ from the ID value set for the NIM. 

• The application is now ready for operation. 
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6 Modbus-over-ARCNET Operation 

When the ARC-EVB and the Windows application have achieved proper communications, the 
Control Panel will affect operation as follows. 

Reading LED Status from the ARC-EVB 
Clicking the Start Button, will initiate the transmission of 
Modbus Function 3H Query Messages (see Section 10.1).  
The application will continually read information from the 
Input  DIP switch (S1) on the ARC-EVB.  Each time the 
read action is successful, the message �RX OK!� will 
appear in the Read Status field.  As long as the ARC-
EVB is working, each change to the Input DIP switch will 
instantly appear in the LED Status area of the Control 
Panel.  Turning a switch �On� lights its associated LED 
on the ARC-EVB and causes its associated LED icon in 
the Control Panel to glow red.  In the example shown in 
Figure 7, switches 4-7 have been turned on. 
While the Start Button is dim, changing the value in the 
Destination ID field will have no effect on the read action. Clicking the Stop Button concludes 
the read action, but the last data read continues to display.  The next time the Start Button is 
clicked, the read function will use the current value in the Destination ID field � but the read 
action will not be successful unless this new value matches the Node ID value with which the 
ARC-EVB was initialized. 

Controlling LEDs on the ARC-EVB  
Changes in LED Control will affect the 
Output LEDs on the ARC-EVB.  LED 
Control has 8 checkboxes.  Each time 
a checkbox is clicked, two things are 
determined � the Destination ID and 
the status of all 8 checkboxes.  The 
checkbox data are transmitted via a 
Modbus Function 10H Query Message 
(see Section 10.1) to activate the 
corresponding LEDs on the ARC-EVB.  
But the transmission will fail unless the 
Destination ID matches the Node ID 
with which the ARC-EVB was initialized. 
Figure 8 shows a query to activate 
LEDs 0 and 2 has been successfully sent to Node ID 1.  The Control Status message �RX OK!� 
only means that a properly formatted query and response were exchanged.  It does not confirm 
that the correct data arrived at the destination. 

Number of Recons 
Network reconfigurations are counted in this field.  The count can be reset to zero only by 
restarting the application. 

 Figure 8 � LED Control 

Figure 7 � LED Status 
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7 Firmware Modification 

The Atmel Flip application included on the CD-ROM is used to modify the ARC-EVB firmware.  
The application includes detailed online help, but a procedural overview is presented below. 

Procedure: 
1. Connect the ARC-EVB to a PC via the provided null-modem cable. 
2. On the ARC-EVB, install the J1 jumper to enable firmware modification. 
3. Apply power to the ARC-EVB. 
4. Launch  the Atmel Flip application.  

Figure 9 � Atmel Flip Initial Screen 

5. The screen of Figure 9 appears with a lower left corner message prompting you to � 
6. Open the Device menu and select a device.  Choose the T89C51RB2 and click OK. 
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7. The screen changes to display the device-specific 
panel with appropriate fields for the T89C51RB2.  
As shown in Figure 10, these fields will remain 
read-only and the panel will remain �dimmed� until 
you specify the communication settings. 

Figure 10 � Device-Specific Panel before Reading the T89C51RB2 

8. Open the Settings > Communications menu 
option and choose RS232.  The RS232 options 
depicted in Figure 11 will appear. 

Figure 11 � RS232 Options 

9. From the RS232 options, choose the Port appropriate to your computer and set the 
Baud value to 19200.  Then click Connect. 
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10. If the ARC-EVB is working and the signal path between it and the PC is proper, the 
device-specific panel will be updated with data read from the T89C51RB2 as shown in 
the example of Figure 12.  (If communication between the Flip application and the 
ARC-EVB is improper, a Time Out Error will occur � check the ARC-EVB and the 
fieldbus cable.)  Leave the upper portion of this panel alone, but make sure (as shown 
in Figure 12) that these adjustments are set in the lower portions of the panel: 

• De-select X2 Mode 

• Set Device SBV (Software Boot Vector) to FC 

• Set the Device SSB  (Software Security Byte)  to FF 

Figure 12 � Device-Specific Panel after Reading the T89C51RB2 

11. To copy a new program to the ARC-EVB � 

• Select the menu item File > Load HEX � and open the desired file.  The filename and 
size will be verified in the lower center area of the Flip window. 

• Under the Operations Flow panel on the left of the Flip window, check these boxes � 
Erase, Blank Check, Program and Verify 

• Click Run.  The checked Operations Flow options should appear green, if successful. 

When finished, close the Flip application, remove power from the ARC-EVB and remove jumper J1.  
The next time you power up the board, it should execute the new firmware. 
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8 Keil Compiler/Debugger 

The ARC-EVB has been designed to work with the Keil Compiler/Debugger.  An evaluation 
version of the Keil Compiler/Debugger is included on the provided CD-ROM.  This evaluation 
version is limited as follows: 

• The compiler, assembler, linker, and debugger are limited to 2 Kbytes of object code�
although source code may be of any size.  Programs that generate more than 2 Kbytes 
of object code will not compile, assemble, or link. 

• The generated startup code includes LJMPs and will not work in single-chip devices 
which are limited to less than 2 Kbytes of program space. 

• The debugger supports files that are 2 Kbytes or smaller. 

• Programs begin at offset 0x0800 and cannot be programmed into single-chip devices. 

• No hardware support is available for multiple DPTR registers. 

• No support is available for user libraries or floating-point arithmetic. 

The following components are present in the full version, but not in the Keil evaluation software: 

• Code-Banking Linker/Locator 

• Library Manager 

• RTX-51 Tiny Real-Time Operating System 

To obtain a full-featured version of the Keil software, use the contact information below: 

Keil Software, Inc. 
1501 10th Street, Suite 110 
Plano, TX  75074 
USA 
      
Toll Free: 800-348-8051 
Phone: 972-312-1107 
Fax: 972-312-1159 
      
Sales: sales.us@keil.com 
Support: support.us@keil.com  

 
 
 
 

Keil Elektronik GmbH 
Bretonischer Ring 15 
D-85630 Grasbrunn 
Germany 
      
  
Phone: (49) (089) 45 60 40 0 
Fax: (49) (089) 46 81 62 
      
Sales: sales.intl@keil.com 
Support: support.intl@keil.com  

mailto:sales.us@keil.com
mailto:support.us@keil.com
mailto:sales.intl@keil.com
mailto:support.intl@keil.com
mailto:sales.us@keil.com
mailto:support.us@keil.com
mailto:support.intl@keil.com
mailto:sales.intl@keil.com
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The Modbus-over-ARCNET server can be debugged on the ARC-EVB using the Keil Debugger.  
Detailed built-in help screens are included with the Keil Compiler/Debugger, but a helpful 
general overview of using the Keil tools is presented below: 

• Set the PC serial port to a baud rate of 19200.   

• Copy the entire Modbus-over-ARCNET server folder to your computer. * 
• Use Atmel Flip to copy the Keil monitor from the MON51 directory to the ARC-EVB. 

• Remove the J1 jumper from the ARC-EVB. 

• Recycle power to the ARC-EVB. 

• Start the Keil compiler. 

• Using the Project > Open Project menu option, open arc_eval.uv2. 

• In the Select Target box, 
choose Debug Image. 

• Use the Project > Rebuild all target files option to compile, link and build the project. 

• With the Debug > Start/Stop Debug Session option, load the target to the ARC-EVB. 

• When the download is completed, 
enter $=0x8000 in the Command 
Line Window to set the program 
counter to 0x8000. 

• Use the debugging options under the Debug menu to single step, set breakpoints or run 
the application.  When the debugging is finished, terminate the debug activity with the 
menu option Debug > Start/Stop Debug Session.  The final firmware to be written to 
the board is in target Flash Image.  Use the Project > Rebuild all target files option to 
rebuild the flash image and generate a hex file called arc_flash.hex.  Use the Atmel Flip 
application to copy the hex file to the ARC-EVB. 

* NOTE:  When copying files from CD-ROM to hard disk, they will be created as read-only 
files, but some of these files need to be updated.  For such files to be used, this read-only 
property must be cleared. 
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9 Service 

9.1 Warranty 
Contemporary Controls (CC) warrants its product to the original purchaser for one year from the 
product�s shipping date.  If a CC product fails to operate in compliance with its specification 
during this period, CC will, at its option, repair or replace the product at no charge.  The 
customer is, however, responsible for shipping the product; CC assumes no responsibility for 
the product until it is received.  This warranty does not cover repair of products that have been 
damaged by abuse, accident, disaster, misuse, or incorrect installation. 
CC�s limited warranty covers products only as delivered. User modification may void the 
warranty if the product is damaged during installation of the modifications, in which case this 
warranty does not cover repair or replacement. 
This warranty in no way warrants suitability of the product for any specific application. 
IN NO EVENT WILL CC BE LIABLE FOR ANY DAMAGES INCLUDING LOST PROFITS, LOST 
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
THE USE OR INABILITY TO USE THE PRODUCT EVEN IF CC HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY PARTY OTHER THAN 
THE PURCHASER. 
THE ABOVE WARRANTY IS IN LIEU OF ANY AND ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED OR STATUTORY, INCLUDING THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE OR USE, TITLE AND 
NONINFRINGEMENT. 
Repair or replacement as provided above shall be the purchaser's sole and exclusive remedy 
and CC's exclusive liability for any breach of warranty. 

9.2 Technical Support 
Technical support is available each weekday (except holidays) during the office hours listed below.  
Outside these hours, voice-mail messages can be left in our mailbox after contacting the main 
phone number.  Requests can also be submitted by fax or by e-mail to the numbers listed 
below, but please leave a detailed description of the problem.  We will contact you the next 
business day by the method you request.  If the problem cannot be resolved by technical 
support, the customer will be given an RMA number so that the product may be returned to CC 
for repair. 

 Contemporary Controls 
(USA) 

Contemporary Controls Ltd 
(UK) 

Office Hours 8 a.m. � 5 p.m. Central time 8 a.m. � 5 p.m. UK time 
Voice +1-630-963-7070 +44 (0)24 7641 3786 

Fax +1-630-963-0109 +44 (0)24 7641 3923 
Email techsupport@ccontrols.com support@ccontrols.co.uk 

Web Site www.ccontrols.com www.ccontrols.co.uk 

mailto:techsupport@ccontrols.com
mailto:support@ccontrols.co.uk
http://www.ccontrols.com/
http://www.ccontrols.com/
http://www.ccontrols.com/
http://www.ccontrols.co.uk/
http://www.ccontrols.co.uk/
http://www.ccontrols.co.uk/
http://www.ccontrols.co.uk/
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9.3 Warranty Repair 
Products under warranty that were not subjected to misuse or abuse will be repaired at no 
charge to the customer. The customer, however, pays for shipping the product back to CC while 
CC pays for the return shipment to the customer.  CC normally ships ground.  International 
shipments may take longer. If the product has been determined to be misused or abused, CC 
will provide the customer with a quotation for repair.  No work will be done without customer 
approval. 

9.4 Non-Warranty Repair 
CC provides a repair service for all its products.  Repair charges are based upon a fixed fee 
basis depending upon the complexity of the product.  Therefore, Customer Service can provide 
a quotation on the repair cost at the time a Returned Material Authorization (RMA) is requested. 
Customers pay the cost of shipping the defective product to CC and will be invoiced for the 
return shipment to their facility.  No repair will be performed without customer approval.  If a 
product is determined to be unrepairable, the customer will be asked if the product can be 
replaced with a refurbished product (assuming one is available). Under no circumstances will 
CC replace a defective product without customer approval.  Allow ten working days for repairs. 

9.5 Returning Products for Repair 
To schedule service for a product, please call CC Customer Service support directly at +1-630-
963-7070 (U.S.) or +44 (0)24 7641 3786 (U.K.).  Have the product model and serial number 
available, along with a description of the problem.  A Customer Service representative will 
record the appropriate information and issue, via fax, an RMA number�a code number by 
which we track the product while it is being processed.  Once you have received the RMA 
number, follow the instructions of the Customer Service support representative and return the 
product to us, freight prepaid, with the RMA number clearly marked on the exterior of the 
package. If possible, reuse the original shipping containers and packaging. In any event, be 
sure you follow good ESD-control practices when handling the product, and ensure that 
antistatic bags and packing materials with adequate padding and shock-absorbing properties 
are used. CC is not responsible for any damage incurred from improper packaging.  Shipments 
should be insured for your protection. 
Ship the product, freight prepaid, to the location from which it was purchased: 

Contemporary Control Systems, Inc. 
2431 Curtiss Street 
Downers Grove, IL  60515 
U.S.A. 

Contemporary Controls Ltd 
Barclays Venture Centre 
University of Warwick Science Park 
Sir William Lyons Rd. 
Coventry CV4 7EZ 
U.K. 
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10 Appendix 

10.1 Modbus Message Format 
The Modbus protocol uses serial transmission.  One Modbus transaction consists of a Query message 
and a Response message.  A Modbus-over-ARCNET message consists of: 

• ARCNET Header 
• Modbus Message 

The ARC-EVS supports the use of two Modbus functions: 

• Function Read Holding Registers (3H) � which reads the status of the input LEDs on the AEB 
• Function Preset Multiple Registers (10H) � which writes a value to the output LEDs on the AEB 

The formatting of these two functions is illustrated below: 

Format of the Read Holding Registers Function (3H) 

     Query  Message 

System 
Code Split Flag 

Sequence 
Number 

LSB 

Sequence
Number 

MSB 

Slave 
Address 

Function 
Number 

(3H) 

Starting 
Address 

MSB 

Starting 
Address 

LSB 

Number of 
Points 
MSB 

Number of 
Points 
LSB 

 
     Response  Message 

System 
Code Split Flag 

Sequence 
Number 

LSB 

Sequence
Number 

MSB 

Slave 
Address 

Function 
Number 

(3H) 
Byte 

Count 
Data  
MSB 

Data  
LSB 

ARCNET  Header Modbus  Message 
 

 

Format of the Preset Multiple Registers Function (10H) 

     Query  Message 

System 
Code 

Split 
Flag 

Sequence 
Number 

LSB 

Sequence 
Number 

MSB 

Slave 
Address

Function
Number
(10H) 

Starting
Address

MSB 

Starting 
Address

LSB 

Register
Number

MSB 

Register 
Number 

LSB 

Byte 
Count 

Data 
MSB 

Data 
LSB 

 
     Response  Message 

System 
Code Split Flag 

Sequence 
Number 

LSB 

Sequence
Number 

MSB 

Slave 
Address 

Function 
Number 
(10H) 

Byte 
Count 

Data  
MSB 

Data  
LSB 

ARCNET  Header Modbus  Message 

Input LED Status 
Occupies LSB 

Data to Output LED 
Occupies LSB 
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10.2 ARC-EVB Component Layout 
 

Figure 13 � Evaluation Board Layout 
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